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Title A STUDY AND SPATIAL ANALYSIS OF RAINFALL DURING TROPICAL STORM
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ABSTRACT

This study aims to study and analyze meteorological physical characteristics during
Tropical Storm Podul affected on the Mun and Chi River basins of Thailand. The spatial
distribution characteristics of both eventual and daily cumulative average rainfall have been
analyzed from on the day 25 August 2019 to 31 August 2019. ERA5 data has been used to
analyze at global pressure and time intervals. Rainfall products derived from IMERG V.06
Final Run system has been used to understand spatial pattern via using spatial statistics such
as Spatial autocorrelation (Global Moran's 1), Cluster and Outlier analysis (Anselin Local
Moran' s 1) and Hot Spot analysis (Getis-Ord Gi*).

The study results provide an understanding into the nature of storm movement and
wind speed, temperature and humidity that using ERA5 weather data each day since originating
in the Pacific Ocean to the dissipating in the Northern Thailand. The storm landing areas may
be less affected than areas that are not directly affected by the storm such flooded aspect.
The statistical analysis results in the Mun and Chi River basins showed that the clustered

patterns of mean rainfall has shown the similarity in the same direction with statistical significance.
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20) gquihavadndneuany Snufiguidiulngiduinudvhuisinuimmiefadu

1

auunava1dnge auiAngiueenanguuilvsiazsufialadaiuguuiganusulINuiagning

' 1%
1 o

uauAUaY Nunguunsuiuusnaswnodani Ymindosdanudminelassudiluaugn Weoussauiu

9 Y

D.

1%
| =

withyaneuiwiiiileguasusiil
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2.5 anyauziiNanllaungn

2
a a =

9 fuuIngn (Meteorology) Wuniswensaldnvuzauiienniaiiiatulusuianiireudng

q

wiug Tnenisussgndiiaiug sendnadnermansiugdaaniviemansaus Wisedy laun

AnwanyuenIonuautiveauinenie 1y aamd AUNAeINIA AUY Y au ne1adailn

Y

|

= = @ v oA Aa a & { o Y Y]
N1SLARBUNYDINIABINA LUUAY WUﬂﬂquLLaSQJ@WﬁWﬁm@W‘UW Wauﬂ‘lﬂ‘ﬁ‘diﬂﬂ‘ﬂﬂumm’]\‘iLLNUQ@M?

¥ '
a1

Wuneng 9 (diney, 2556) Inedivadelunisnsiseiniasiail

7

., L g

AN 2.5 1A5831995398104 (LESA, 1.4.4.)

1) eungil (Temperature)

2) ANuNARINA (Air pressure)
3) L

8) Ymasiegnani

5) iy

6) ay

7) AUIEE 1150 SLEEMNTAVIAMITAIYAN

2.6 Afigu Global Precipitation Measurement (GPM)
A1L7183 Global Precipitation Measurement %58 GPM tJuna1sian1uiisusgninalseind
dunansallusasingialannng 3 49lu Wulpsenisaausauiienuszwing National Aeronautics

Space Administration (NASA) & ¢Japan Aerospace Exploration Agency (JAXA) Sudadudetud

o '
(9 =

27 nuAUS 2557 Useneunieiasesdotugaidunnsgiu lnddwsunistausunaiduaineanie

Y

(National Aeronautics and Space Administration, 2017)
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M1 8 Global Precipitation Measurement %38 GPM USUU3 90 81191nA134L9 8
The Tropical Rainfall Measuring Mission #38 TRMM tiiefnuuazasiaianisnseatsuaynsiuuys
vosuluuniou A19A9T0In1TIBN GPM JA1Nd1A A on1911ANNL T 3@ NN ALAZEA TN
nliomafidsuanssnusievsanimuandelan aunsntludssendld el
1) USuupsmnudifentuiginsvesinedanuaranudoslesfumadeunasaam
nilenna
2) deyaidednlnifiAvriugai@ndnsnszaeivesuinamiidu lassadamiguas
nsvurumslutuussermavelg
3) arwanssaiafslumsasaseukazmAMIaingLEesiAULaT AN TAlaA e AT
USRI
6) Usuupenuaunsolumsneinsaidniudessauravizues nsfaivhusouduas
Aunay
5) finggmsvinnefiardmiuanimenAuazylennie

6) NISNYINTUNVNANIINTITNYATNAVULALNITAANIUNTNEINTUIN

AN 2.6 ALBY Global Precipitation Measurement %38 GPM (NASA, 2017)

2.7 wansnuaiury IMERG V.06
Integrated Multi-satellite Retrievals #58 GPM tJugana3fuuuusiuAug vosansgaLuina
inanduaUSuaruLasfnguadin GPM ansgoisnt lunesduagade 0.6 Ineldidugasuuy

Passive microwave Tun1saiaazwuudsunuiiny felgoanasnulunisaiunulann 9anasyiu Goddard
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Profiling 2017 (GPROF2017) T U159 nTui s US Ui sufunE ad el GPM Sanesiiy
Combined Ku Radar Radiometer Algorithm (CORRA) TaeilAa1uazid aatdafiuiivindy 0.10x 0.10
Alaluns 9 CORRA L sun1susuliidfundnsdni Global Precipitation Climatology Project (GPCP)

Satellite Gauge (SG)

¥ '
] =

WAASUTTHY IMERG V.06 annsansianseuaquituiivilandeus 90 esmuile fa 90 asald
wAASusiAL IMERG finisvhauianan 3 svuu dun s90v Early Run wansdoyaniondsnisnsiata
4 §913 53UV Late Run udnadayaniondslsuszana 14 $alsmdsannardananisal uagszuy
Final Run Lannadayan1evainIsnsivin 3.5 - 4 inew Jaguusyuu Early Run uagseuu Late Run

galuifinsagunisasuiieunsousuui half-hourly Tuvaeiissuu Final Run yimiuiiin1susuud halfhourty

Y

MW 2.7 Foya IMERG wansusnaiidwhuanmelsuioulusgvinda (NASA, 2561)

2.8 Yoyafnnuan1wenIA ERA 5

ERAS \Juni1sdiasnesineansalainiaialanves qudwensaleinimszeguiunasuiselsy

'
1 o o v

(ECMWF) sufividmsunsaaaninenianalan Tuyis 4 s 7 nadsseisiuun ERAS dnslvdeya

Haguuliaausd 1950 TnesifiAuteyaanimgiiennia dmiul 1950-1978 wagsiausd 1959 uduly

(Fugnenseun1ssumaanuiian)lng ERAS Tiiudeyaluguuuy ERA-Interim reanalysis

v
¢ o

Ing ERAS 1un1simsizignassiudeyasuudiassiunisdunanisalanialaniiduyadeyad

6

auysaluazaenndasiuiilan Feandnnisganiudeya (data assimilation) 184mna3sn1sldlnemue
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L3

wgnsaloInIAdeinaInn o Falue nsaan1salaTaneulrgnTINdIiun1sAIan1salaseluy

'
1 5%

ludnwaeNmigaungaiiiaasian1sussaunsiudnanan winiuauaziduananaieliaiunse

v
& o v o w

Inwnssnyadeyadeundlulavalenaissy mawsgvglifitedndnluniseannismnnisalluiiani

(% [
v = a =<

winngan Astudsiinaintulunissiunuteduns wazilledounainauly

ToyaseiiuauAy ERAS sedaluasaudt 2502 felaqiu WWudeyasiln ssuunin lneaseunay

[
o LY

a Y = = a ¢ = | a P
a%ﬁ‘gﬂm'ﬂaﬂ ‘Vlﬂ')'?ﬂJﬁSL@EJ@ﬂ'ﬁ'JLﬂi']gﬁ"?ﬂlﬂaﬁaq 0.25x0.25 93fn LLagﬂiaUﬂquiuLLuja@ﬂﬂﬂﬂ‘mi%ﬂﬂ

1000 hPa 14 1 hPa fimuagtden 37 sefuauiy Aausd 250299t (ECMWF, 31.U.1)

ERAS January 2016, Mean Speoad in Temperaturo

AN2.8 FBE1ITaLaRANINANTNEINAYDY ERA 5

Y 1
=~ )

2.9 @AN15AATIZIALTINUN

aa a ¢ a A a - -y & a ¢ aa 1% a & A
A0 N1FILAIVEKRLVINUN (Spatlal statistics) L‘U‘Lm'iS‘U?LIﬂTi%Lﬂi’]%ﬂ%’]ﬂﬁﬂ@lf\]’lﬂ%a?,{l’aL‘N‘WL!‘VI

[ ' [ '
(2 el = el =

Favayall Ty UUNANS 1989 LU ULATAINITAAIUINAIAUANURLTINUN DU LIHBNITUINUIINUT

[ '
= =

anurrRIU FUNUSITINuEd wazAnududourasanduiusiBanud M euloadanui NMsInsIea

sULUU Stlenuduiussendneiuldsienisauiumendineans (P.A. Longley,2005)

14
v g A A

2.9.1 ONEARFUNUSLTINUT (Spatial Autocorrelation)

[ '
v Y v = a =

SRANFUWUSLTINUT (Spatial Autocorrelation) A9 AITAIUIIUIATADA LN DLARS

v '
v 6 = a

AMUFUNUSLTINUN

1%
1% 1 (% v 6

7ilee) FuUTeunsununNlnalAsuas Rl lndlAesiy sAanduiusvesnuy

& 1 i
N =

egAnfiuiauameafsiunaeniaiunAne uansidadausuenfanduiusidanunluniauinegs

a9 lumansethuiudmanduiusvesiunegfiniuilnnuuand ey uanedimainuavenisandusiug

Y

o X
WFNUA L UNI9aY



19

v o g

1) 33mavidunusideiiufl Spatial Autocorrelation (Global Moran's 1)

[ i Yo LY

aa aa al i v o sa X A & A
L‘UUﬂqumﬁ@UﬁﬁmqﬂaﬂﬂVﬂ AAITETAUAITUANNUTEUINUN LL‘U‘Uﬂs@U?’]a‘NWUW

[

WeszydnuursUluudeiiuiivesdeya 1UFULUUMIINNENGN LUUEN Lasiuunseany lagluTeuiey

Y Y
v

AR UA Anwriudunyadus Tngldan z-score 30 p-value AsIaRURAYUS ATANYAFIY

AagnsAsalull
n n
n Zi:lz_j:l wijZiZj O
- g o3 S0
0 =171 i=1j=1
AN 2.9 dUn"T Spatial Autocorrelation (Global Moran's 1)
[T | Ao AMAIUdUNUSTILD LS
n A AnuIulSunaeuEzaY (Saduns)
Z;, Zj Aa Usinaelulugnnm i uay]

wi; AD AEILNUINTBIAUWLIRAN TN | Ua
X Ao AnadsUunaeluayay
So AB ANRAEENINVIN TR ILUUIAN WATVLA
TR8AIAITUFUNUSLTINUNVOILBLIY TA1SENING =1 09 +1 AAIINAIANTUNUS LT IN UN

U I

Tuiiemadeaiu S3UwvudSuasluazauwuuilungu (Clustered pattern) wnfiAdnlng -1 waneind

Y
anduiusiganunlufianimsainy Isuuuunisiialsaluunszatsda (Dispersed pattern) wagninien
Wi 0 wansindinisnszanedveslsuaHudzauwuugunsetlifisunuuuwiueu (Random pattern)

(81393, 2564)

Dispersed -ﬁ Clustered

NILIANTLAY GUERGH]

AN 2.10 anwazgUluunsnszaeitvesdsinaeuazan (esr, sd.4.)
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2.9.2 M5ATIINITNIZNGULATAIRAUNG Cluster and Outlier Analysis (Anselin Local
Moran's )

nsinIznguiazAIRiaUng (Cluster and Outlier Analysis: LISA ) unis@inwiluuiiiu

fufinuan ANTIUENTERUNSINENGLGIVTR Lﬁaa%maé’ﬂwngﬂLLUUL%aﬁuﬁfuaaLLUULmzmjm

vosrgsiimiioufuldun high- highuas low-low TastgUuuunIsinznguueseifiegnssdnufuldun

high—low wag low-high ienaaauAININIENauN 4 sULUY 1dNsingnauegiitudAgynieada

Fisumitlag mmmmﬂammu (@13913, 2564)

XN S jeilt — )’
xi —, _ Coaaalxs =
& _ 2 _ &j=1j#FI\"]
Ii = 52 wi,j(xi X) Si = 1
B\ 4=1,j=i
AN 2.11 d@un1s Cluster and Outlier Analysis: LISA
Taed 1, fin Areuduiuswoudauladaus oy
n Ao MunuvTunanhruazay ([@adun)
X; Ao USunaurhiluganm |

X fla AnmdeUTunasuasay

B AOINMINTEWIUNAITANIN | LAY j

L

wij

% #e AAnuwdsUiu

saa

lny Aranduiusndanduvin AeuSuaduasauiiog usalndidsaiu danniloudy

'
a1

= | ] ! ca &) = a H Ql' A ¥ LY ISP ' LY
LaZNNIILNITNYH dIUATEUAY UINAANIUAY ﬂ@ﬂﬁu’lmumﬂu@%ﬂmﬂ@QU?L?M@iQ‘UW@Jﬂu UATRINNUY

'
a

. ﬂquﬁﬁmqq Q(H—H) ﬁaﬁuﬁﬁﬁﬂ%mmﬁmuazauﬁqaIummzﬁﬁum%nmiau

'
a

= ﬂa;:uﬁﬁmﬁﬁ—m (L-L) ﬂawuﬁwmsmmﬁmuamuﬁﬁw Tuvauzifuiiusinmsey

1 [y

v 2 a 3 A o
Y NUUANUTUI UL N UALFUNHNBUAY

'
a

" NauNNAEe-A1 (H-L) ﬁaﬁuﬁﬁ“‘d mmmcluavawm Tuvaueinuiiusnnseu

o

v 2a a
mquuﬂmﬂimmumua AUNGN

Aaa = =

" ngundanen-ga (L-H) Aofuifiiusinaiuayaudisn Tuvagfifuiiuinuse

Y

¥ @al o d
mquummﬂimmumuazawqq
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pan “h
— ey
Input Local I Index P-values Cluster Type

AN 2.12 waé’ﬂwngmwwaq Anselin Local Moran's | (esri, 1.4.4.)

2.9.3 mMsiaszangandlan Hot Spot Analysis (Getis-Ord Gi*)

9

mMyinzigngenalen (Getis-Ord Gi*) 1JunsusvennsinenauiuvestoyaiiiAngs

wilaufiufe Hot spots hagn1sinignquiuvesdeyanilAiniileouiuae Cold spots 1ngazA1uIN

z- score WIOMINUA ¥38 AUMITINFULUUNSINIENGY (8713015, 2564) AsgnsAuasaluil

n
Y wixp— X B wij 7 Li=1%

[nZ _ W= (Zn 1Wl.1)]

n—1

51

- (X)?

AN 2.13 @115 Hot Spot Analysis (Getis-Ord Gi*)

el G; Ao AlAZLULLIATHIUAINALTIUGYEY Getis-Ord fiiumidle o

n fn P1ulSunasuazay (Jadwnsg)
x;  fe WRanaslulugan i
X Ao AnadeUsunoeluazay

wi; A9 ANENUIVLNYDIAWVLIIAN N | Uag |

L

S Ap AdlBuULLnTEIl

"-'"' 7y

Vit €~

Inpu? Z-scores ' P-values

2N 2.14 naanwalr§ULUUBe Getis-Ord Gi* (esri, 1.U.4.)
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HATNEYRY GI* LanseanunluguwuuYes Z scores Milmnuduiusvedoyaiuaada tioufias
auNFgILAD ANaN (mean) ALTB9ULNINSEIU (standard deviation)

" 61 Z=0 uaneibifisyiuumaimengviseuuuduiganui wselifid wedfanetis

¥ '
c a A d

B A1 Z<0 WanId AN U uSIB e unlun19uIn 8181 Z scores WuAIauNIN
Uauaniiaguiuunsingnguueiuiiisi-s (Cold spots)

" a1 750 waasindanuduiusigeiuilunisuin 4161 Z scores tuaAIuInuan

UauonfaguuuunIsnznguesiuiiiige-gs (Hot spots)
Tudiuvesrnsziumaidedunieena fu Z scores
B 90% s¥AUAINTRIIY - >= 1.645
" 959 syAuAINLERITU: S= 1.960

" 999% SyeuUANITeTY: S= 2.576

o/

2.10 W@NEISHAZIUIFENNYIVDS

a

#i7ns g (2563) Imvinnsanwinsusediuiasnisuszandlinsannivervesdoyauunm

9

WUHuAINKERSusiTayanILlex Integrated Multi-Satellite Retrievals for GPM (IMERG) luuseimeilng

1% '
Y 5] )

fnquazasdndnvoenisided (ousziduyszdvs nnudnsaeindusefusardnvus deiluiives
ATt IMERG) 1asdu 06 TuszezlnduuuSealil (IMERG-Early uag IMERG-Late) wazlwasiSoalni
(IMERG-Final) w3suifisufuamdunanisalnieiiuiu 121 WisInnsugaieninenlne (TMD) fidswn
AsANEIUIEANS MU IMERG wafiuiivesusumalng Tneldeadalunisussdulaunn CC, MAE,
RMSE, RB uagisn1sussfiuamnin POD, FAR, POFD, CSI wagnnsussidunanfausiiisiu IMERG V06
Tunsa$rauvuiaemmsgnnineddunsiuszaueiu seiieu 5167 wazamggnialutasiud 16
nuAUS 2014 8 15 nuALS 2019 wudikAnSagiind IMERG V06 Havandanuansalunis

(% sala

A5293UUS UIAUUNHUNA T AUAUNUS 71 5 lhazeoa g el olUS s UL o U uUANSEUNANISUAIAN UAWAN

[

nsugallesine (TMB) aanfinsiadnusunaniay lngsiuwdiussanSamveaaniamiaeiiii IMERG

Vo6 Namuaduwildunazdsedivdsinanirululssmalvegaiulddmsvssduseiu mobeu el

v e‘d‘d v

waragan1a MAE uag RMSE eglusyivgalugauulaeiimnuduiusnaluszauggniauniinnuduius

Y

lusgauunansluggiou wdndugidueiundi IMERG a1nsasndunsnszateuTunalunivssna

ngladusa luhuesdgifuiugluuu@siunvesaniding TMD USunanlnusigiuasauiuduain
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AAMLENIN1ATA 1RSI LA LT ULINUSIUTISH IR T UDDNLALATUALTUANYDINIALAUDIUTELNA

a A

Tne Tuntensstudy Jlusininundluniamils A1ANaNY kazA1ARLIUEaNL 8Nt avaIUsEINa

v 6 v

Ine dmsunisdassmegnning) winduainnazneuves IMERG vauailanuduiusasiudnsnisiva

Y

Whlunisdaesiuuinass NAM 1nnindeyanisanasnauuuiuauainaniduaiinesvesnisiirie

NARWAIUTEMALNY (ANE.)

AN nosduns (2563) nAnwinisSsuiigudsianusieTuseninsdoyandnsdneiuieuy

[ '
) a0 1

IMERG V.06 wagdoyanumaiupuiuiduuiungs lngld38n1mneadia laun Bias, Root Mean Square

q

Difference (RMSD) Wa¥. Mean Absolute Deviation (MAD) 443 altfuil Bias Luddgyuagle@nuinig

Ao 1%

WIsuiiieu3sn1sUssu AL BINuIved Bias AATIan 97w 3 35 Lawn 38 Inverse Distance Weight

(IDW), Triangulated Irregular Network (TIN) Lag Nearest neighbor wu31¥ ey ausuiuuduna

1%
|

wuAud g g Usunanhruiaiale nudntaeiiiEy IMERG V.06 taeduetiudviznarasyis

Y

[
LY

W1y 9 wenanil llatTeuliisuanulwYefersstayanandneii kY IMERG V.06 eiivianun 3

s¥UU laun Early Late uaz Final wu31 szuu Final )uszuuiidanudnidetouniign sesaswniu

o
a a

52UV Early wag 52UV Late mudiau uaisnsussanaandoyaaiuniinvian fie IDW 1Juisnianan

a1 d‘

Fatimeduanuuanmsluseuy Early Late wag Final lawn 0.028, 0.004 Lay 0.044 Jadiumns auaau
9381 aauazaug (2562) lAnwigUuRAnIsaluazn1saesIgRdai unvesnsiinuzis el
[ [ [ ¢ A a & v a dy a" = wva L3 8 @ [ [
Janinuasnuy dnguszasdiiedinsentadeilisiiuiivag@nwau® nisalusiswivludminuasnuumna
MsfinwInudn guRnsaluzseiu Jminuasnuy 22.5 s Ussrnsuaunausiod (95% Cl: 21.5 - 23.5)
N153A129 Moran’s | nudkUsnfiauduiusidenunluiianie wedfuwuuiniengy (clustered) aga
T Ayn19adf (p < 0.05) LAuNTEEYMIRINWRE LT AMUAUILLL UTEYINT LATAIINAIDIN
v % a I3 ° ! ° a a 2 o Y 1w
TEAUUIMELA N15TLATIEY LISA 310 99 siua na us1vad iaugisaiy laundaudsaiugs
INTLAVUINLLA 4 AU FILUTTZELUIRINLMAIUY 22 A1Ua AAWUIAUNUILUUYDIUTEYINT

14 9ua
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A TAUNUIY

MsfnuIdeiies Mgt dudsiuilugmngleudoulnna nsddnw quihya
uarguin® weliussanuingusvasdiifuualudnisdiiiunside Taefineasdeauiadu 4 d
fail

3.1 Yeyauaguvastoya

3.2 1eR0vile gunsnl wagwenmwiflilunside
3.3 nMafiusivdeya

3.4 MFIATIENTRYA

3.1 doyauasunsetaya

M1919 3.1 Yaualazivasivestoua

doya TH Y9781
1. %’aaﬁaﬁmmmmwmmﬂ ERA 5 Copernicus 25 d.A. 62 - 31 d@.A. 62
2. Yeyanniiigunandaauy NASA 25 &.A. 62 - 31 @.0. 62

IMERG V.06 $2UU Final Run

3. YULYAGHIN dinauninen sl s 2564

3.2 1A%0sile gunsal uazvavldufldlun1sade
1) ﬂamﬁamafdauqﬂﬂa Acer Nitro Ryzen 7-3750H CPU 1@2.30 GHz
2)  Wsunsumeansaumaniimans ArcGIS Pro 3.0.2
3) TUsunsu jupyter notebook

4) TUswn5U Microsoft Excel
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< v
3.3 NI13NUIIVIIUVDYA

va 4 a

v v & 19 P~ = & | 9
N'JT’UEJ"L@I‘VI']ﬂ'ﬁLﬂ'Uﬁ'J‘Uijmsﬂam‘jaw%ﬁ‘Uﬂqiﬂﬂ‘UqWﬂﬂﬂJﬂ 3 @u ‘lﬂLLﬂ VDUARARNUANINDINA ERAS

Y Y

v
a LY & o

HARNAUNUINY IMERG V.06 LLaZ“ZJJE];JHGGUE]ULSUWEjiJﬁ’] Wefnwinaglinseidnvundegndenine uas
é’ﬂwmzmiﬂizmaéﬁL%Qﬁjuﬁéuaw%mmuazauﬁ'ﬁﬁai’uuazmm@;miai Tugramglnga
3.3.1 YayaRnAINaNINaINA ERA 5

1) allnandoyadnniuanineinia ERA 5 hourly data on pressure levels from
1959 to present 7 51 A3IUAZL8 ¥ALTAAY 0.25° x 0.25° 173 n151as ECMWF a1nvSuled
https://cds.climate.copernicus.eu/cdsapp#!/dataset/reanalysis-era5-pressurelevels?tab=overview

2) yinstdvaya fann 3.1 1den Product type: 153152357 (Reanalysis) 901
ﬁmuﬂ@fuwiﬂgﬁwum 8 s lawn Divergence, Geopotential, Relative humidity, Specific humidity,
Temperature, U-component of wind, V-component of wind, Vorticity (relative)

3) MVUATEAUAITUNABINIA T TEHUAIIUNABINIA 850 hPa A9nIn 3.2 (a)
wagivual Weu U 1ateniglngs A 3.2 (b)

4) e uiinsgiaansuvuialan danm 3.3 (a) Mauadeyaanalnd NetCDF
(experimental) aanE AR Submit Form Lﬁawﬁ'}ajwﬁmnﬂuamﬁﬁ’agaLﬁaﬂizmamaLa%LLé’ammmnm

ailnandeya fanamn 3.3 (b)

Product type

Reanalysis () Ensemble members (D Ensemble mean () Ensemble spread

Selectall  Clearall

Variable ®

Divergence () Fraction of cloud cover

Geopotential [J Ozone mass mixing ratio

O Potential vorticity Relative humidity

() specific cloud ice water content () specific cloud liquid water content

Specific humidity (D Specific rain water content

[ sSpecific snow water content Temperature

U-compoenent of wind V-component of wind

([ Vertical velocity Vorticity (relative)

Select all Clear all

A 3.1 MyuaAAILUIYeIleYn



( a) Pressure level

O 1hpPa (D 2hPa O 3hPa (J 5hpa
O 7hPa O 10hPa O 20hPa O 30hPa
(J 50 hPa (O 70 hPa (J 100 hPa [ 125 hPa
(J 150 hPa (3 175 hPa (J 200 hPa (O 225 hPa
(O 250 hPa (J 300 hPa (J 350 hPa (J 400 hPa
(J 450 hPa (0 500 hPa (J 550 hPa (0 600 hPa
(J 650 hPa (3 700 hPa (J 750 hPa (3 775 hPa
(J 800 hPa (J 825hPa 850 hPa (J 875hPa
(J 900 hPa (0 925 hPa (J 950 hPa (0 975 hPa
(J 1000 hPa
Selectall  Clearall
(b) Year
1959 [ 1960 1961 1962 1963 O 1964
0 1965 O 1966 1967 [J 1968 01969 O 1970
O 1971 O 1972 01973 D974 01975 O 1976
O 1977 1978 1979 [J 1980 O 1981 O 1982
(J 1983 [J 1984 [J 1985 [ 1986 [ 1987 [ 1988
[ 1989 [ 1990 1991 (1992 01993 O 1994
[ 1995 [ 1996 [ 1997 [J 1998 [ 1999 O 2000
0 200 (0 2002 (0 2003 [0 2004 0 2005 0 2006
O 2007 O 2008 [ 2009 [J 2010 O 2011 O 2012
(02013 O 2014 O 2015 O 2016 02017 O 2018
2019 (0 2020 [ 2021 [ 2022
Selectall  Clear all
Month
() January () February [ march O April [ may () June
O July August ([ september [ October [ November () December
Selectall  Clearall
Day
Dot Doz Doz Ooa Dos Dos
Qo7 Oos Oos O On [ERF]
[WRE] 04 (s O1e 0 Ore
019 020 021 D22 023 O2a
&2 26 @27 ™28 M2 M 30
31
Selectall  Clearall

A 3.2 dvuea1vesdeya (a) seauaunee1nie (b) U ey Tu

Geographicalarea ®

®  Whole avallable region

T p———————

Subregion extraction @

"

) 0
Format (b)
= ® eLCDF esariment
Tenms of use
o Lomcetous Coperia Froduts Wew ey

= e =
(a)

o

A 3.3 MyuaA1vesdeya (a) Nunngiimanswuulantazanalng (b) a1dlvan
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3.3.2 uAnswsiiHY IMERG V.06
1) emailnanndnsiasiindy IMERG V.06 fiflanuazden 0.1° x 0.1° dsldunaindoya
aniiey GPM Al¥u3nnslag Goddard Earth Sciences Data and Information Services Center (GES
DISC) %8484A NS¥89 National Aeronautics and Space Administration (NASA) annid ule &
https://giovanni.gsfc.nasa.gov/giovanni/
2) vinnslddeya e 3.4 Teefmuagasasuduauianadugaise fukaz e
wansal Inefvuaveulniudifideinisninilnan waziimn Keyword 1y IMERG udana Search

(% L3

PNUUILUIINYToyavaINansniuHy IMERG V.06 Tivihnsidendeyanindngindeinisaiilvan

(%
v =

Lﬂu%’ayjaﬂ'%mmﬂfmusmi’u f1#uA Temporal Resolutions 1w Daily INUUEONTLUUHAR el
fioamsAnuufusgun Final Run 91n4unn Plot Data

3) doganinilnanszfuoyasuiuunames (Rasten) s1ivnMsaluazemgsal
freg1e Fanm 3.5 uae Nty Download Tnsidendesaiidesnisaniinanidutoun GeoTIFF Lol

'
aa v

eayaniii

e

GIOVANNI 11 5dge Between Dsta and Science v4.37 Feedback Help  Log out (apichaya_62)

(combined R) estimate - Final Run daily 0.1 deg. [GPM GPM_3IMERGDF v06]

A 3.5 Jayanansinaiiau IMERG V.0651ewwmsnsainagyinisandivaaiiveld@nwm


https://giovanni.gsfc.nasa.gov/giovanni/
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3.4 M3nszidaya

3.4.1 M3AATIVTILARAAINENTWDINIARIN ERA 5 fnglUunsy jupyter notebook

1) dnmssudeyainniuanineinie ERAS liduwana NetCOF Lilulvainesineniu

a a

Aulrdussananalusunsufilddulsunsy jupyter notebook Liedmszsidnuusidenenineilaun

gounndl fiAmawazausIay aausiun 25 - 31 dwnan w.a.2562 1dlAalunisuszananayaiediu

uifvuaATTukazIaEeiY AN 3.6 Mvualausisuagiwlsussinanaliiogudayaas REAS

(a)

#LAmualawaRlsananstaya

df = xr.open_dataset('era5_daily_sum1_7aug_2019_globe.nc")
print(df)

# 3.AmuaA T
lon_ = df.longitude
lat_ = df.latitude

time_ = df.time
temp_ = df.t #aaunaid
lev_ = df.level
print(temp_.shape)

<xarray.Dataset>

import numpy as np (b) Dimensions:  (longitude: 1440, latitude: 721, level: 8, time: 28)
import xarray as xr Coordinates:
import cartopy.crs as ccrs * longitude (longitude) float32 0.0 0.25 0.5 0.75 ... 359.0 359.2 359.5 359.8
from cartopy import feature as cf * latitude ~ (latitude) float32 90.0 89.75 89.5 89.25 ... -89.5 -89.75 -90.0
import matplotlib.pyplot as pit *level  (level) int32 200 250 300 500 700 850 925 1000
import pandas as pd *time  (time) datetime64[ns] 2018-08-25 ... 2019-08-31T18:00:00
%omatplotlib inline Data variables:

d (time, level, latitude, longitude) float32 ...
#2.81uniaYnERA 5 thowy Twas z (time, level, latitude, longitude) float32 ...

pv (time, level, latitude, longitude) float32 ...
r (time, level, latitude, longitude) float32 ...
q (time, level, latitude, longitude) float32 ...
t (time, level, latitude, longitude) float32 ...
u (time, level, latitude, longitude) float32 ...
v (time, level, latitude, longitude) float32 ...
W (time, level, latitude, longitude) float32 ...
Attributes:
Conventions: CF-1.6
history:  2022-07-25 20:27:51 GMT by grib_to_netcdf-2.25.1: /opt/ecmw...
(28, 8, 721, 1440)

NN 3.6 TupBUN S MUAAYRItoya (a) 1ARSuAY (b) naanstoyanield

Y

2) TATIERUNQE Avua U-1ou-1u-93901a1-58A UAINANDINAR WA TUA 25 - 31

Fevan W.A.2562 2 gasanlald 00:00, 06.00 UTC fisgduaitnaa1nid 850 hPa savsuUasmthe

watulusmaldeasndiagalaniui 25 a.a. 62 fan1n 3.7 (a) wasiilasumdsazlanasnssanin 3.7 (b)

(a)

#3uvi 25 &evnan 2562 13a71 00.00 viszdua11unaaInIA 850 o
temperature=temp_.sel(time="2019-08-25T00:00:00.000000000' level=850) # I3 2d a0 daius
temperature_30aug_00=temperature-273.15 #uilaviaaiuiuisaidos

temperature

xarray DataArray 't (latitude: 721, longitude: 1440)

( b) £ amay(([272.1938, 272.1938 , 272.1938 , ..., 272.1938 , 272.1938 , 272.1938 ],
[272.17337, 272.16928, 272.1652 , ..., 272.18765, 272.18356, 272.17743],
[272.01614, 272.00595, 271.99573, ..., 272.04474, 272.03656, 272.02637],

[239.84848, 239.84439, 239.8403 , ..., 239.86072, 239.85664, 239.85255],
[239.88318, 239.88113, 239.88113, ..., 239.88522, 239.88522, 239.88318],
[239.679 , 239.679 , 239.679 , ..., 239.679 , 239.679 , 239.679 ],
dtype=fioat32)

v Coordinates

longitude (longitude) =

latitude (latitude) =

level 0 ) S

time 0 ) =
v Attributes:

units : K

long_name Temperature
standard_name :  air_temperature

AN 3.7 FURBUNIAMUAA1YEITBYE (a) MruAYIIal (b) naansdeyanieule

Y
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1
a

3) YmInaeauruigugiiansunduladularlangsouvesiud 25 a.a. 62 L3a1 00.00 UTC

[y

N38AUAIUNAUTIEINTA 850 hPa lagAvuaLdulAILNENY0IYBYaTIuenUAA1 9 v Ta9gn

Wiy 42 83f1 UaraunIAgAvay 10 891 NUUAMNUATYDILNUTLABNMINAUMNLANYDY

q

=Y

ToyauNuNianIn 3.8 (a) Wesumdazlanadnsianin 3.8 (b)

(a)

(b) Temperature of 25 august 2019 at 850 hPa (Celcius) time 00.00
—~ =

-4

¥

L

&)

[celcius]

5

ok, Inewidth =1) #ufivu iz edsan pyplot
= cartopy.

perature of 25 august 2019 at 850 hPa (Celcus) time 0000, fontsize=15)

ittt
pltshow()

AN 3.8 TunauUNINaRRLNUNgUNAN (2) 1AR (b) Naaws

A A

4) HNISNADALNUNAANIILAZAMULS ANz N U D UlndulazlaesaUYRIUN 25 d.0. 62

1381 00.00 UTC M58fUAINNAUTIEINTA 850 hPa lnginunf @ ulAtALTITeI Uy aTIuianviunal

'
o

ANUEIANGIAAMNAY 28 e/ AWRkazagawiniu 0 wes/Aundl danm 3.9 (@) Wesufdrlana

Ansaan1w 3.9 (b)

#arurn1AIINEIA% Wind speed wind vector of 25 august 2019 at 850 hPa time 00.00
WS = np.Sqri{u**2+V*+2) — —— =

pit.figure(figsze=(10,8)) 400N

ax = plt.subplot(111, projection=ccrs.PateCarree())
ax.coastines()

ax.add_feature(cfeat.BORDERS)

ax.set_extent([80, 125, 0, 40)

#ax.set_extent([75, 125, 0, 25])

ax.set_ttle(wind vector of 25 august 2019 at 850 hPa time 00.00')

max_=28

#max_ = npround((np.max(ws))+2

min_=0

#min_ = np.round((np.min(ws}))

vstep = 1.0

levels = np.arange(min_, max_, vstep)

owf = ax.contourf(x, y, ws, levels, cmap="et, \
extend="both', transform=ccrs.PlateCarree()) 20:N, . 3 & 2

#wan colbr bar
# Auaiiiaua (heght_of_image [ width_of_image)
im_ratio = ws.shape[0]/ws.shape[ 1]

char = pit.colorbar(Cw, fraction=0.047+im_ratio)
charset_abel([m/s]’, fontsze=15)

#wind vector
Q= ax.quiver(x[::3], y[::3], u[::3,::3], v[::3,::3], scae=30, color="red", pivot="mid’, units="nches’)

#scale wind vector
#qk = ax.quiverkey(Q, 0.9, 0.9, 20, r'§1 \fiac{m}{s}$. labepos="E’, coordnates="igure’)

#uadrdiania nsudauniaduTaze
gl = ax.grdines(draw_tzbels=True)
gltop_abels = False

glright_labels = False

(a) (b)

AN 3.9 TUNBUNITNADALNUNTIANILazANLEIaY (3) 1A (b) Nadns
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[
a

5) YINANSWABALNUNAINUT UFUNNS RN U D UlATULALIAYTBUYRITUN 25 d.A. 62 1380

00.00 UTC 7isgiumnunausseIna 850 hPa lagfivuad1idulasinuiivesdoyasiunaiivunay

[

ANNBUFURNSFIanwAY 0.024 (kg kg**-1) LLﬁ%G?W?jG]LVhﬁU 0.000 (ke kg**-1) fan1w 3.10(a) Wiio3u

q

AdazlanadnsaanIn 3.10 (b)

### nassunudidytafusaniini lansavs i nnbyaamiFumeisry 850 hPa
(3)  metasmaman (b)

from cartopy.util import add_cycic_point
import cartopy.feature as cfeat

pit.figure(figsize=(13,6.2))
dd,

e e S e e Specifc humidity of 25 august 2019 at 850 hPa time 00.00 (kg kg**-1)

mapers = central_longtude=100)

00216
# Amuasuaia

datacrs = cers Pl
0.0192
ax = plt.subplot(111, projection=mapcrs)

ax.set_extent([80, 125, 0, 40], cors.PlateCamree()) #nusvavimaususi

#max_ = np.max{uw_cyc) 0.0168

= 0.024

(D 00144

#m o) -
st :‘
ev e(min_, max_, vstep) opl2os
humid_ = ax.contourf(lon_cyc,\ =
= o
= o00ss 2
levals\
transform=cars.PlateCarree()\ 00072

cmap=1er)

0.0048

ax.coastlines(resolution="110m’, color= h\a(k hne\.ﬂdth lJ
ax.add_feature(cfeat BORDERS, Inestyle="") #uif:

wwazadaann pyplot

00024

b ax.g;d\ines(dmv:hhe\;:True)
gl.top_labels = False
glright_labels = False 90°F 100°F 110° 120°

0.0000

ight_of image / width_of image)
cshape[0]/uw_cyc. shaue[l]

= pit.colorbarhumid _fraction=0.047im_ratio)
char;et - label('[kg kg=*-1T, fontsize=15)

p title('Specifc humidity of 25 august 2019 at 850 hPa time 00.00 (kg kg**-1)', fontsize=15)
pk.show()

watumsmaaan

AN 3.10 TUABUNISNADAKNUAANUTUFUNNS @) 1An (b) NadnsS

3.4.2 N159A513US U U AT aNNNNAAN Ul IMERG A28lUswnsd ArcGIS Pro 3.0.2

(Y 1

= a € a it; [ a v [
gn aamﬂﬂizmumiﬂmﬁuammewﬂammmﬂumamwm&lmimmmamnm% IMERG

Aagatane 3 35 NellunisTieseiuTunaiduazansieme Ty auadun 25-31 dwneu 2562
& ad a v o X o v a o % N & o o ¢
Judtnsweifudeiliiteyandndeiuinu IMERG V.06 iannilvanaunnesieiunazsiemnniseal

Tusuuunawmesitgluunsunisasaumegienans lWswnsu ArcGIS Pro 3.0:2

£%
| o

1) finveualdananeiuNgudiyaiazq uui¥iioanseezlialun1suseulIanaliledain

9

' '
v

Indvayanansimanuiey IMERG duunalueg) Inelaadanuau Toolboxes 1971 Data Management

Tool > Raster > Raster Processing > Clip Raster A4 3.11 (a) 91n1uazUsINVTe19U81A3 8319

£%
v & o [

Aan 1 (b), (0) sadmsfimesiagluges Input Raster hamwandasidwudulszianteyasanes
Wnn 9 nduluges Output Extent dendudeyaveuian Nuiin1sAnwiidulssinndeyaiinmes
fanw 3.11 (b), (c) wazgAdNLAS 8IMUIY Use Input Features for Clipping Geometry 6 asnlue o3

Output Raster Dataset Tidenfidaiudegaaintu na Run azldnadnsanin 3.1 (d), ()



= 3 - v
R oy D Cwteiow ey O Geoprocessing v ax Geoprocessing

® Clip Raster @ € Clip Raster

) @ x

Parameters Environments EamelersJERUICh DS

Input Raster
onCal.20190825-20150831.89E_ON_112E_22N1tif ~
Qutput Extent

mun_sum

Input Raster
onCal.20190825-20190831.89E_ON_112E 22N ~
Output Extent

chi_sum

- ~
Rectangle =

=+ 104.838108873219

1| 17.6734468112461

es for Clipping Geometry

) Maintain Clipping Extent

(a)

(o)

(d)

AN 3.11 TURDUNIIFAUBULYINUTINNSAN® (a) kaururAIadile clip (b) nthd1sweansadle clip

(C) NUWINIVOUATOMD clip (d) HAANSNITAAVULUINUNAIANY

2) nsusuuiaauazdenvasiniga Laeldad s Resample Tunauins sede Data
Management Tool > Raster > Raster Processing > Resample Lﬂ%"aﬂﬁaResampLe Tulusunsy ArcGIS
Pro 3.0.2 f90 3.12 (a), (b) mﬂﬁ?uﬁ]wi']ﬂgwﬁwhwam,ﬂ%aﬁaﬁqmw (0) wammsimelasludos
Input Raster thannmanfariinuiiraands 1 antuluges Output Raster Fonfuiidauiv fvunen

X @AY =0.01 wana Run 3ELANadnsoanuInenIn 3.12 (©) wazlauan Sourcesnasusu

31
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- ==
(a) Favorites Toolboxes Portal (b) 2 EoliE=my (C) Geoprocessing v R X
I &s Mosaic Dataset ® Resample ®
: 3D Analyst Tools » & Ortho Mapping
Parameters Environments @
b

& Raster Dataset

! Analysis Tools . Input Raster
4 @7 Raster Processing

[ dip_sumr -]

; Aviation Tools “\ Clip Raster Output Raster Dataset
_ ] #_ Composite Bands clip_sumr Resample |
[ Business Analyst Tools & Output Cell Size
Compute Pansharpen Weights ‘ o ‘
——]| *., Create Color Composite
b §em Cartography Tools P » oot ¥ 1]
_ “\, Create Ortho Corrected Raster Dataset & Technique
== i
[ - Conversion Tools “\, Create Pansharpened Raster Dataset ‘N EEEEE t V‘
- . =
I Crime Analysis and Safety Tools BxtractSiibdataset
. #\. Generate Table From Raster Function
o] ili
I §em Data Interoperability Tools G B T ETED)
= =
‘ Data Management Tools Resample
*., Split Raster

AN 3.12 TUABUNIS Resample NUINIsAn® (a) hauAunIAIodie Resample (b) ntid1auss
1A5094l9 Resample (c) BUINNNT0AT095D Resample (d) NadWsNISARURULYANUTINIIANE

(e) WaA1 Sourcesuaausu

1%

A ¥ =
Wugmmawagahmaammu
3

a

3) ¥n1seuaniAn Zonal Statistics as Table Wil uaaAnads
Uaya Spatial Analyst Tools > Zonal > Zonal Statistics as Table 901 3.13 (a) kazALUTINGNTFNS

YOIAFITUNIINUUNNUAAINITIELNDT AN 3.13 (b) MYUA Input Raster or Feature Zone Data

o

Juveuaiiufidnen fAmua Zone Field 1udeguuiges: SB NAME, T-99ntdunivun Input Value

v
v 6

Raster \unmndndusidndufivihnsuSunimnuazidenainde 2 wagiden Statistics Tape Tiduns

NsAIWINEBRNNEDR 9InUunA Run aglemsisAaifieantnninin 3.13 (o)
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Geopracessing v X

-
4 e Fonal ~
(a) s (b) ® Zonal Statistics as Table (]
“., Tabulate Area Parameters Environments
~ inpirt Raster or Feature Zone Data
Zonal Fill sum.
Zone Field
5 58_CODE
Zonal Geometry Input Value Raster
P
Zonal Geometry as Table
- Zonal Histogram ;a-lt‘:.‘:i-r::w“lu culations
pistics Ty
s o All
Zonal Statistics Percentile Values
Y
“*. Zonal Statistics as Table @ Add ancther

(@

i sum_zonal X

Field: ?E E Selection: Ejg

QD 58 HAMET ZONE CODE COUNT AREA MIN

MEAN  sTD MEMAN PCTSD  5B.CODE SB_MAME_1 ME_CODE MBASIN T MEBASIH_E AREA SN

1o sebamecumn 1 1 3¢ 0D 1312418

o u
..... M
o Mu

Mu

o Mu

..... M
o u

M

o Mu

Mu

o Mu

Mu

o u

M

zasmmns 018 o Mu

AN 3.13 TURBUNITAIUINZonal Statistics as Table (a) LaUALLASa9ile Zonal Statistics as

Table (b) tiA9vATaB Zonal Statistics as Table  (€) A1519NANITATUIAADS

4) Y sfiumTeAad e lavinnsAIuIuaInte 3 adlu Shapefile Y3aULIANUNANE LAY
N15AUNILAS 890 join Field 1A 0eil9azaylu LauwAT 93lle Data Management Tool > join and

Relates > join Field A9 3.14 (a) 93UsNYUEIW19UaRAS8IN8 join Field Tuunlvivinnisiinun

s

AMNTEmes Input Table 1un15198d# waztden Input join Field WufinAdoauul 9andusing

q

1A join Table WunpuuniunAnwiuazidan Input join Field \ufadTequin udine Run fanw

32.14 (b) wazlANadNSILRLAIS19ANGEDATIUINININ 3.14 (©)



(a) Geopracessing v I X (b)
@ {join| x v| @
Join Field (Data Management To -

Permanently joins the contents of a table to another table based on a common
attribute field. The input table is updated to contain the fields from the join tabl...

-

(@)

& munsum X

Field: fE Add B Calculate  Selection: Ui Select By Attributes

Geoprocessing
() Join Field

0 Thistc fifies the Input Tabl

Parameters Environments

Input Join Field
SB_NAME_T
Join Table
sum_r

Join Table Field
SB_NAME_T

AN 3.14 FURBUNITINNAITIAEDTH (a) LaUAUMILATEIED join Field clip (b)

5) YUNBUAIUIN

%@%aLLUUﬂi@UﬂQM

L4 U d' =) P F o U aa
MU NYDUATIND join Field (c) MTINANITATUIVUANEDG

34

Fafufi Spatial Autocorrelation (Global Moran's 1) 31A51%%

nuA iasEUdnwugULUUIGNNvaIeNa I1UFURUUMSINIZNEN LUy

LAZLUUNTZAY Immﬁaﬂﬁuaumémﬁaﬁamw 3.15 (a) Spatial Statistics Tools > Analyzing Patterns >

Spatial Autocorrelation (Global Moran's NAgUs1N)NHIANUDAATIAINTUYINNIINIUAAIMNITITN DT

\don Input Feature Class 1 voutvan uiguiiiilasande 4 iden Input Filed Luanade adn

\A3 9INUIBY N7 Generate Report L oLF AR @i @ 910 Wi en Conceptualization of Spatial

Relationships 10U Inverse distance f1mun Distance Method 10U Euclidean 31n1unA Run #ann

3.15 (b) nadwslaleenunduuuy Report fanw 3.15 (), (d)
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Geoprocessing v BX

(a) 4 [R2a Spatial Statistics Tools (b)
G Spatial Autocorrelation (Global Moran's | &
4 &s Analyzing Patterns

E_[ Average Nearest Neighbor

E_[ High/Low Clustering (Getis-Ord General G)

E_[ Incremental Spatial Autocorrelation

i)

Multi-Distance Spatial Cluster Analysis (Ripley's K Function)

i

Spatial Autocorrelation (Global Moran's )

() (d) 34

Spatial Autocorrelation Report Global Moran's I Summary

Moran's Index 0.800878

Moran's Index 0.800878
z-score 7.755161 .
p-value 0.000000

Expected Index -0.019231
Variance 0.011183

neooom

z-score 7.755181
p-value 0.000000

Dataset Information
Input Feature Class: mun_sum

Input Field: MEAN
Conceptualization: INVERSE_DISTANCE

- Distance Method: EUCLIDEAN
B .l Row Standardization: True
Frix
o B O Distance Threshold: 47363.2178 Meters
Onpersed Random Custared

Weights Matrix File:

None

Given the z-score of 7.755181, there s a less than 1% Bkelihood that this clustered pattem
could be the result of random chance.

Selection Set: False

AN 3.15 TUADUNITANUIMNANANAUNUSITINUT (2) LOUAUMLASDILE Global Moran's | (b)

PIRN9UB9AT8495I8 Global Moran's | (¢) Naannn1sAIu Global Moran's |

6) Funoun1TIiATIEnITINEnauLaZAIRAUNR Cluster and Outlier Analysis (Anselin
Local Moran's I) finwnluufina fufinuadnainsnsenssfunmainmengugwiesi ioasunednume
sUuuuLd s uiivauuuiniengu Tnsidentuouia osilodanm 3.16 (a) Spatial Statistics Tools >
Mapping Clusters > Cluster and Outlier Analysis (Anselin Local Moran's I) ﬁ]zﬂi’lﬂgwﬁ’lﬁi’mﬁummém
M uinafvuaAsdines ien Input Feature Class L vauiuaiiufiguinfildainde 4
@A Input Filed Jurneds anduden Conceptualization of Spatial Relationships U Inverse
distance fviug Distance Method L¥u Euclidean a1nifuna Run fan1n 3.16 (b) wadnsitlalieonan

Jusuuuudnwaensdangy fdann 3.16 (o)



(a) Spatial Statistics Tools
b &= Analyzing Patterns
4 &« Mapping Clusters

Ef Build Balanced Zones

|Ef Cluster and Qutlier Analysis (Anselin Local Moran's )

Ef Density-based Clustering

Ef Hot Spot Analysis (Getis-Ord Gi*)

Ef Multivariate Clustering

EF optimized Hot Spot Analysis

Ef Optimized Outlier Analysis

5 similarity Search

Ef Spatial Outlier Detection

Ef Spatially Constrained Multivariate Clustering

(@

dmpaan A0
memeusitesauft 1
4
uf 3
Tumeines S1hiReus

e smssaNR 2

. 4 amhda
dneudand 1 ke .

et A dniamd s AmiAenfian S 1
dnfnsuidndl 2 AL dnhfndlaz v

Sowgt dn@enlunidnd

NSz Aminiidonh 272 o

Ll St v, Yauien ATy
Amiridni 211 i ) 2

2

B o

y  dmbineusn
dndentioy o fagunedn@z

(b)

o v S
dun anbyadmfiziz dmdman o
6 niuaduflzs

: o .
amsou 2/1 amhyadoun 2/5

vy

e
“d agagedand 1

ot
il g EEoR sl ot
dmbyadoudl 2 3 inyaseuansdouT
A P Aminyanauanydn 2 3
S anhwadoutl an “"’l":&““ ST
M Trunpdnd 2 g e 7
Yawii L x Py Amiyarauangnm 1
dmiygadauf aig el

anlaulun

Geoprocessing v B X

(© Cluster and Outlier Analysis (Anselin Local... (B

D

o)

Parameters Environments ®@

é

Input Feature Class

mun_sum:1 -]

Input Field
MEAN ~]

Output Feature Class

[ mun_sum_ClustersOutiiers |

Conceptualization of Spatial Relationships

Inverse distance v
Distance Method
Euclidean ~]

Standardization

Row v ‘
Distance Band or Threshold l:l
Distance

] Apply False Discovery Rate (FDR) Correction

e

High-High cluster

High-Low outlier

Low-High outlier
- Low-Low cluster

Not significant

36

AW 3.16 TUABUNITAIINNITNIENGULAEARNAUNT (a) WOUAUNILATEND Anselin Local Moran's |

(b) MA19UDLATD9ID Anselin Local Moran's | (¢) Haannn1sAulad Anselin Local Moran's |

7) TusBUNITIATIERYAFERaUan Hot Spot Analysis (Getis-Ord Gi

1 U v d'd 1 = v A
NRUNUYDIVBYANUATEN LUNDUNUAD Hot s

Y Y

<

* 1 JUN1SUIUDNNITANY

pots Wagnsingnguiuvastayanimamilouiufe Cold

spots Tneideniiuauini esiionenin 3/17 (a) Spatial Statistics Tools > Mapping Clusters Hot Spot

Analysis (Getis-Ord Gi*) 9U31n)WII919U84A5 0931NU UNIN1TAIMUAAINISITWBS LHoN Input

Feature Class 10 u vautvaii uilquu1ilaannde 4 1don Input Filed tduated s anduiden

Conceptualization of Spatial Relationships J U Fixed distance band A% un Distance Method

\Ju Euclidean 91n1una Run fsnm 3.17 (b) waansilalioanundusuuvudnvaensiangy danm

3.17 (c)
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& Spatial Statistics Tools (b) - R x
(a> b & Analyzing Patterns (®  Hot Spot Analysis (Getis-Ord Gi*) @
A {1 Mapping Clusters Parameters Environments @
Er Build Balanced Zones Input Feature Class
‘ mun_sum:1 v
Er Cluster and Qutlier Analysis (Anselin Local Mor Input Field
5 : : [mEAN -]
Er Density-based Clustering
Qutput Feature Class
| Hot Spot Analysis (Getis-Ord Gi¥) [mun_sum Horspots |
— Conceptualization of Spatial Relationships
(Er Multivariate Clustering \ Fixed distance band v \
Er Optimized Hot Spot Analysis oDma_"ce Method
‘ Euclidean ~ ‘
Er Optimized Outlier Analysis Distance Band or Threshold I:|
Distance
Er Similarity Search Self Potential Field
Er Spatial Outlier Detection (] Apply False Discovery Rate (FDR) Comrection

Er Spatially Constrained Multivariate Clustering

g
WeIReUA1AIT 1

4
i 3
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AN Sumnedni 1
o % 40 g
smidretngni 2’ HIEAMMNE Ty
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fnsza Aminfidoui 212
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Amir3dqud 211
dnzunaga 1

T Sy &
d yadaud AMyAREUATIAIN 2 3
byl TR u;“‘ il T I Cold Spot with 99% Confidence
WhensTag T heioiu s mv.:;mdﬂ 2 dminarauandnd | N N
dfogadouf arz ) Litmriog I coid spot with 95% Confidence
dmingadoudi a/a Cold Spot with 90% Confidence

Yem dnlanslvy o
‘huw‘nhuﬂ ‘m il Not Significant
hudany Hot Spot with 90% Confidence

- Hot Spot with 95% Confidence
- Hot Spot with 99% Confidence

AW 3.17 TunpuNsAINngenalen (a) wauAunAsedle (Getis-Ord Gi*) (b) ntsnsvaaIaile

(Getis-Ord Gi*) (c) Ha1NANSANUIU (Getis-Ord Gi*)
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181 IMERG V.06 52U Final Run Aeasn1syngans dnan1s338wuani1sitasIsy
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a

4.1 dnwagn1NIgn TR dening  nglnaaandeyafanisan weinia ERAS

4.2 A15N5LYFTINUNVDIUTIN U UALELNNAN N U9 LN IMERG V.06 S2UU Final Run

RN ARG AL

4.1 §NEUENINIENINLITRATENINE NG INAAIINTLARAANENTNEINIA ERAS
1) gaungdl

HANIITIATIENENYULNIINIEANT 18 A TaUTNEIVoINIEINA S WUTIE WL
voargunil (Temperature; T) Turasmnauseanns 26-27 aee vasennglnaaisunedluiun 25 a.0.
62 WJungaumunAeINIARIUIIALMANSRUTTN denn 4.1 aziulddfufuuinaussinedy
a = aa I a = o oA aa = & =
Feauuiigamiingandnusnannignedinumaynsuldiin esiniian 00.00 UTC iWuiainaisdu
iliusnauaunsldldsveasinalenfindvilviigangisiiniiusiauiiuiu ieiiai 06.00 UTC

wignImasusstudungfsaty aziulaingamn)igaluausnunuAuwas iayns wazgund

Y

A Adaumluneirnz Tusnn Tuiui 26 ., 62 fenw 4.2
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(@) (b)

Temperature of 25 august 2019 at 850 hPa (Celcius) time 00.00

Temperature of 25 august 2019 at 850 hPa (Celcius) time 12.00
JIE— g Y

35°N

30°N

25°N

15% 200N % g
150N s - 150N :H
5°N 5°N
AN 4.1 UHUTQUUHTUT 25 BnAN W.A.2562 7is¥aumUNABINTA 850 hPa
(a) 00.00 UTC (b) 06.00UTC
(a) (b)
Temperature of 26 august at 850 hPa (Celcius) time 00.00 Temperature of 26 august 2019 at 850 hPa (Celcius) time 06.00
NS E] W0°N B
25°N # son 34
w°N * g 2000 % g
28 28

15°N

10°N

5°N

Au A

AN 4.2 unuiionmniiiui 26 dsneu w.A.2562 iseduANNABINTA 850 hPa

U

(a) 00.00 UTC (b) 06.00UTC

o A [

wiud 27 a.a. 62 wiglanimawsudumglousou 19a1 00.00 UTC wisuiuindousmiu

—2

UseinanduTudameiaduld danam 4.3 deunludun 29 a.a. 62 wigaanaidlandoutulausnandes
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ABdges Ussimnadenuny lulsewea vibivssmalnesulasunansenuainmig danmn 4.5 wigle
VRUANILAUIINUMALNSWATRUNA NG UsneAuliianiudutdy dewalinianeuuuvessemelngisy
1A5udvE antumngldtuiled .dies a.uasnun Juil 30 a.a. 62 wazgeuidwaadungisatudnin

4.6 Tuui 31 a.0. 62 @aanufdungasAIUNADINIARIAINING. 7

(@) (b)
Temperature of 27 august 2019 at 850 hPa (Celcius) time 00.00 Temperature of 27 august 2019 at 850 hPa (Celcius) time 06.00
BN )
30°N 38 30°N 38
H 34
250N 5N
30 _ 30 .
2°N * E 20N % %
o u
24 n&
150N 5 BN 18
14 14
10N 0N
10 10
son 5N
:s' aw A a P )
AN 4.3 N UVIREUNNIIUN 27 @9MAU W.A.2562 NIgAUANNNABINIF 850 hPa
(a) 00.00 UTC (b) 06.00UTC
(a) (b)
Temperature of 28 august 2019 at 850 hPa (Celcius) time 00.00 Temperature of 28 august 2019 at 850 hPa (Celcius) time 06.00
— S
N 3I5°N
30°N = 38 30°N 38
E 34
=N 5N
n_ 0
m —
0°N B E_, 200N 26 g
s )
2= zs

15°N

10°N

5°N

Av a

AW 4.4 uNuTRVITUN 28 A W.A.2562 NITEAUANLNABINTA 850 hPa

U

(a) 00.00 UTC (b) 06.00UTC
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(a)

Temperature of 29 august 2019 at 850 hPa (Celcius) time 00.00

e

35°N

(b)

25°N » - . -
15°N 15 5
o 14 14
AN 4.5 UHUTQUUHTUT 29 AN W.A.2562 s¥AUAUNARINTA 850 hPa
(a) 00.00 UTC (b) 06.00UTC
(a) (b)
Temperature of 30 august 2019 at 850 ha (Celcius) time 00.00_ Temperature of 30 august 2019 at 850 hPa (Celcius) time 06.00

30°N 38 30°N E:]
=N 0 5N N
e ZEE 200N zsé
BN 18 15°N s -
10°N " 100N 1

10 10

5°N

5°N

Au A

AN 4.6 ULHUTNRUNYTIUN 30 FnAu W.A.2562 NSeAUAIILNABINIA 850 hPa

U

(a) 00.00 UTC (b) 06.00UTC
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(a) (b)

Temperature of 31 august 2019 at 850 hPa (Celcius) time 06.00

Temperature of 31 august 2019 at 850 hPa (Celcius) time 00.00
-

R
[celcius]
]
=
[celcius]

5°N

AN 4.7 unuigauv)Tun 31 Ganau W.A.2562 N52AUANLAABINTA 850 hPa

(a) 00.00 UTC (b) 06.00UTC

a <
2) NANI9LLAZAAIULTIAN

NANTIATIZRANEAEIINIENITgndasdnevemnglnga wuirdnuwaznsiadou
#2097 An1suazaA11IL§ a1 (Wind Speed and Direction) lud29am1g vaizd wig lwa ais uneda
Tududl 25 a.n. 62 1undonanunneIA AR IANINALSUUTIATINA 00.00 UTC Ans§isey
gudnans 0 uon wasSamimdwusdudungfwsaduiinan 06.00 UTC fanmidisaugudnais 30
uen #3901 4.8 niungldiad ouslunensfiansfunnvmsdunigfusadudng ouda
oglunmaunsUTAnmesunziusenvesinizgueu Uszimalaulud Tududl 26 dsmiau 2562

AN 4.9 MgENAFeURNTIWUR N 4.10
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(a) (b)

wind vector of 25 august 2019 at 850 hPa time 00.00
- 1 ~

wind vector of 25 august 2019 at 850 hPa time 06.00
—— ] 1

e ¥

AN 4.8 UEUNAANISLATAILSIAN Tl 25 AaAN W.A.2562 NsEAUAINNABINNE 850 hPa

(a) 00.00 UTC (b) 06.00UTC

wind vector of 26 august 2019 at 850 hPa time 06.00

s

a 0°N

AN 4.9 WHUNTANIAZAINUEIAN TUTI26 FaMAL W.A.2562 AISEAUANNNABINIA 850 hPa

(a) 00.00 UTC (b) 06.00UTC

Tutui 27 a.0. 62 wglinimdustudumglaudou fanusisaugudnaisnng 35 uoansou

.1 a

AutadousiuUssmandududamsiadulaluiufediiu danim 4.10 Tudun 28 a.a. 62 Wiy 13udl
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[

ANUEITEUAUGNa NNt Y 40 uom Maan 00.00 UTC wag 45 uen Akial 06.00 UTC fan 1w
4.11 \i8a1nvaan 00.00 UTC Wunanansdiuviliusnaummgunsiildsuuaninaiseiindwinduia

06.00 UTC dawalianuiamigiiaunniu aninguusulagamzudnauiuniivesmefiidizuwse

dUNAINANYULVDWMILINMBTANTVUIANETT TN 4.11 UThagudnatemedauunyuly

SNYUSNIUTUUIRNN

(a)

wind vector of 27 august 2019 at 850 hPa time 06.00
—— T :

wind vector of 27 august 2019 at 850 hPa time 00.00
| TSR T =

AN 4.10 LNUANAN1IRATAINSIAL JUN 27 B9AN W.A.2562 N5EAUANUNADINTA 850 hPa

(2) 00.00 UTC (b) 06.00UTC

(a) wind vector of 28 august 2019 at 850 hPa time 00.00 D) wind vector of 28 august 2019 at 850 hPa time 06.00

AN 4.11 LLNUﬁﬁﬁVINLLﬁ%ﬂ’J’WL%’JﬁN JUN28 FINMAN W.A.2562 NITEAUANNNABINA 850 hPa

(a) 00.00 UTC (b) 06.00UTC
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a IS

soulutuil 20 aa. 62 Kanw 4.12 wgldiedeutuieuiinauiiosnesses Ussmadaaunn s
Uszimaad vz dsnadunigloufounazianuiisevaudnais 45 uon Jauszinalnei3uldsu
wansznuaINdvEnamglngalisunsannidesntoudsssmalnemgazUsng o dutiud
Ussimadenuuieudnguszmelne Tuuil 30 a.a. 62 11an 00.00 UTC mnmiiaseuguinatsnganas
wde 35 uem niouanmdsandumesaduinan 06.00 UTC fanm 4.13 wazanidsassaioniu
neauaunne N Anluiudeany TngngouanunaeinianidanalauLUnagunin

[y

pziuenuLnlonar AT TUUS NN A9nIw 4.14 dsuavinlmdaduanuindsdnuinlunane

4

=D
=b.

U

(a) (b)

wind vector of 29 august 2019 at 850 hPa time 00.00

wind vector of 29 august 2019 at 850 hPa time 06.00

AN 4.12 WHUNTANIRAZAUEIAL TuTl 29 FINAL W.A.2562 NIZFUAILNADINA 850 hPa

(a) 00.00 UTC (b) 06.00UTC
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wind vector of 30 august 2019 at 850 hPa time 06.00

2 30°N

10°N

AN 4.13 WNUNTRANIILALANUTIAY TUN30 F9MAL W.A.2562 N5AUALNABINIA 850 hPa

(a) 00.00 UTC (b) 06.00UTC

(a) (b)

wind vector of 31 august 2019 at 850 hPa time 00.00 wind vector of 31 august 2019 at 850 hPa time 06.00

40°N

21 309N

30°N

20°N

AN 4.14 LLNUﬁﬁﬁVINLLﬁ%ﬂ’NNL%’JﬁN TUN 31 AN W.A.2562 NIsEAUANNNABINA 850 hPa

(a) 00.00 UTC (b) 06.00UTC




47

3) AUIUFUNNS

HANTTILATIENAN BN N8N NTIg HeuTne1vesniglnga wuidnuarALTy
s (Relative Humidity; RH) wudn Tusasmnguasiimglwnaisunosaluiuil 25 aa. 62 fanm 4.15
JundeuanunaeiniaiuinuumaynsuUdfinfinat 00.00 UTC uazidunimdaussd udung
Fusaduiing 06.00 UTC mntumigldiadeudalunismsiinns funnunzfumgiisadudundeud
ogluuvmaynsuUaTnmeiuagTueenvesnzgeeu Ussmamautud luiuil 26 e 2562 fanw

4.16 lgthanurududunamnnanninayns winugussslitung

(a) (b)

H e H 1 ok
Specifc humidity of 25 august 2019 at 850 hPa time 00.00 (kg kg**-1) Specifc humidity of 25 august 2019 at 850 hPa time 06.00 (kg kg**-1)
0.0216

00216

0.0192 00192

0.0168 00168

00144 00144

1]
1]

00120 o120 %
o

*
o

k

0.0096 2
X 0.0096 g

00072 00072
0.0048 00048

00024 00024

0.0000

0.0000 5
S0°E 100°E 110°E 120°E BO°E 90°E 100°E 110°E 120°E

AN 4.15 WAUNAINUTUFURNS TUN 25 FIAU W.A.2562 NSLAUAINUNADINIA 850 hPa

(a) 00.00 UTC (b) 06.00UTC
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(@)

Specifc humidity of 26 august 2019 at 850 hPa time 00.00 (kg kg**-1)

0.0216

0.0192

0.0168

0.0144

1]

(b)

Specifc humidity of 26 august 2019 at 850 hPa time 06.00 (kg kg**-1)

0.0216

0.0192

00168

00144

00120 1;, 0.0120 ﬁ:,
0.0096 lc‘n 0.0096 E‘
0.0072 0.0072
00048 0.0048
0.0024 0.0024
20°F 0.0000 20 0.0000
AN 4.16 BLEUNANUIUFUING JUN26 Favay W.A.2562 NSEAUAUNABINA 850 hPa
(a) 00.00 UTC (b) 06.00UTC
Tutud 27 a.0. 62 wglanimawsudumnelyudouiundeudriulsamaiauludamea

Fuldlutudeaiu danm 4.17 Tiud 28 a.a. 62 wig 13ufinnnuiSasaugudnansnig g uyily

QUNANUAZAMUYUANTY AN 4.18 LT18391n19a7 00.00 UTC lunainasAuvinliusiaumauns

LildSuuasanaeiindivinduiag 06.00 UTC dsmalininmimieiinanntu dnnudugs

(a)

O‘

%

=

S0°E 100°E 110°E 120

Specifc humidity of 27 august 2019 at 850 hPa time 00.00 (kg kg**-1)

0.0216
0.0192
0.0le8
oo14s
0.0120

0.0096

[kg kg**-1

ooy2

c.o0a8

00024

0.0000

(b)

Specifc humidity of 27 august 2019 at 850 hPa time 06.00 (kg kg**-1)

f
5

00216
00192
00168
oo144

o120 ¥
o

—
|
3
o
0.0096 =
00072
0.0048

00024

0.0000

AN 4.17 LEUNANUTUELINGS TUN 27 F9AL W.A.2562 AsEAUANUNABINTA 850 hPa

(a) 00.00 UTC (b) 06.00UTC
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(a) (b)

Specifc humidity of 28 august 2019 at 850 hPa time 00.00 (kg kg**-1) Specifc humidity of 28 august 2019 at 850 hPa time 06.00 (kg kg**-1)

0.021%

00216

0192 00192

00168 : ! 00168
2N " 0
i 00144 _ o | e 00134 _
{ = # =
00120 % . norz0 ¥
g2 2
t
oa0ss 2 A no0se 2
=3 5N =
00072 00072
10°N /
l//_{ 00048 ﬁi 00048
=N
00024 — 00024
0.0000 - 'g 0.0000
°E

90°E 100°E 110°E 120 120°E

AW 4,18 unuTimuTudining Sufize Fanen w.A 2562 Tiszdurnunae A 850 hPa
(a) 00.00 UTC (b) 06.00UTC
sowlududl 29 a.. 62 fanw 4.19 wgldiadeutuilsuinmuiiomoses Ussimadoauny w1y
Uszinaan sandsnadumglouieunasianuisisougudnans 45 uem SeUszimelnaisulasu

HansenuINBnEnanalnnalususswniesnnneudsusamalnenigagensduwuiiiionian

'
v v oa

sutiufivssimadauunawdndUszmalne i linganid wsmaisnnusiay aamall auay
Tutud 30 a.n. 62 wioanfdsauiumefiusaty daniw 4.20 wag AN 4.21 dwalinludiui

A Y v ' & Ao a 1%
waeumuiungurUnpuiuiuunan lulsemalny

(a) (b)

Specifc humidity of 29 august 2019 at 850 hPa time 00.00 (kg kg*=-1) Specifc humidity of 29 august 2019 at 850 hPa time 06.00 (kg kg**-1)

0.0216
0.0192
00168
00144

0.0120

[kg kg**-1]

0.0096

00072

00048

0.0024

0.0000

v ¢ v o

AN 4.19 Lquﬁmm%ué’mwmﬁ JUN 29 FIMNAU W.A.2562 ﬁi%ﬁUﬂ’ﬂNﬂﬂaﬂﬂﬂﬁ 850 hPa

(a) 00.00 UTC (b) 06.00UTC
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(@) (b)

Specifc humidity of 30 august 2019 at 850 hPa time 00.00 (kg kg**-1) Specifc humidity of 30 august 2019 at 850 hPa time 06.00 (kg kg**-1)

00218

0.0216
0.0192 00182
0.0168 00168
0.0144 _ 00144
~ —
ll .
00120 ¥ 00120 %
o o
e x
00096 2 00036
= =
0.0072 0.0072
00048 0.0048
0.0024 0.0024
~ 00000 00000
o0°E 100°E 110°E 120°E

AN 4.20 WAUNAINUTUSUNNS TUT3Z0 BIVAL W.A.2562 NSEAUAINNNABINF 850 hPa

(a) 00.00 UTC (b) 06.00UTC

(a) (b)

Specifc humidity of 31 august 2019 at 850 hPa time 00.00 (kg kg**-1) Specifc humidity of 31 august 2019 at 850 hPa time 06.00 (kg kg**-1)

00218 00216
00192 0152
00168 b0168
00144 00144
— —
i y
001203 00120 ¥
= g2
00035 00036 2
— —_—
00072 00072
00048 00048
00024 00024
0.0000 00000
90°E 100°E 110°E 120° 0°F 100°E 110°E 120°F

AN 4.21 LEUNAMUIUEUINS JUN 31 FAL W.A.2562 N5EAUAMUNADINTIA 850 hPa

(a) 00.00 UTC (b) 06.00UTC
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4.2 N1515818ATINUNVBIUS U uazaNIINKARN 9 UIHY IMERG V.06 52UU Final Runfaeg

A5N15N194D6H

v

1) ANSIATIEAOATNFUNUS L BINUN
a 6 v U a dyj dl a dl 1
HAN1TIATIBRENBUENITNTEABANTINUTvoIUT I weivazay Tudimiglnga

FIEMANITUAILNENAUINUIEY IMERG V.06 58UV Final AIwATuN 25 - 31 dawaw w.a. 2562 Tuiui

(%
Y] v W

vasguiyakazauund Ingldisn1satfonanduiusienun (Global Moran's ) HaaN15ILATILYTE

WAl A9RN919 4.1 wud) Nunguidiyaiian Moran's Index, Expected Index, Variance, Z - Scores,

a1 1w

P-Value fiAuvinifu 0.800878, - 0.019231,0.011183, 7.755181, 0.000001 sxdsu Tudruvesiufigu

Rt ﬁ'ﬂ'ﬂ Moran's Index, Expected Index, Variance, Z — Scores, P-Value AALYMIAU 0.641281, -

v v ' 1 (%
(Y] 1 o {

0.038462, 0.011210, 6.419959, 0.000001 MUFFU kaENINUNGUUYALAZE NI TL A A UANAUTUS

Y

[ '
=

Waunluieniadgaiu laud susuudSunaslueeasaniuuinizngy (Clustered pattern) 118331019

' (%

| o

unguIyawazaunT A1 Z = Scores 11NN71 +2.58 wansdiamuduiusi@anunlunisuinegedl

Y

=D

§ @

vd1AEV9EnA P-Value to8n11 0.01 M198AUAMUTDNU 99 [WaSiTuaA

e

4
o A

M13149 4.1 Global Moran's | Y@siuNgNUIakaYaLUNTTIMANI 0l

Moran's Index Expected Variance = Z - Scores P-Value fg‘ULL‘U‘U
Index
@:N‘E”Iyla 0.800878 - 0.019231 0.011183 7.755181  0.000001 mj:u
@:N‘E”I% 0.641281 -0.038462 0.011210 6.419959  0.000001 mj:u

1% '
a A )

HANTIATIERANYUENITNTEAUMITINUTvesUTIaNuRi sazau Tug g lngasgiunie

WansuaiaY IMERG V.06 3¥UU Final Aausdud 25 - 31 &wnau w.e. 2562 Tuunivesguiiya laeld

(% ' ¥
=

FevsadAsnanduiusiGeiui (Global Moran's ) Fanan1siiAs1zsisneiu fn1s1s 4.2 wudi fufigu
PRt @1 Moran's Index, Expected Index, Variance, Z - Scores, P-Value qﬁqmiufuﬁ' 30 d9uAy
e, 2562 Fuduuiinagduil e Sunoifios Swiauaswuy Ussmalne Savindy 0924281,
-0.019231, 0.011270, 8.887637, 0.000001 MIUA1IAU La¥iiA1 Moran's Index, Expected Index,

Variance, Z - Scores, P-Value fnfigalududl 27 Aamau w.a. 2562 fawvindy 0.279856,-0.019231,

v 1 '
o ISP % A s

0.007396, 3.477814, 0.000506 Awd1dy laefiufiguinyadisemanduiudidsiuilufienafotu

Y
laun gUuuvUSuauad sagauwuuinignay (Clustered pattern) L9499 IN UT g UL AL AN

9 Y
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[ aa

Z — Scores 11AA17 +2.58 LanifsAudunusigenunlunisuinegelidudrfAgnisana P-Value dae
111 0.01 MszduANuTeiu 99 1Wesdud

M13199 4.2 MIUATIER Global Moran's | Yesiiuiguinyaseiu

E4

quinya
Suil Moran's Index Expected Variance  Z - Scores P-Value g‘lJLL‘U‘U
Index
25/08/62 0.619618 -0.019237 0.010407 6.262269  0.000001 &
26/08/62 0.784852 -0.019231 0.010964 7.679355  0.000001 ngu
27/08/62 0.279856 -0.019231 0.007396 3.477814  0.000506 ngu
28/08/62 0.565290 -0.019231 0.010789 5.627452  0.000001 nau
29/08/62 0.882741 -0.019231 0.011183 8.529474  0.000001 ngu
30/08/62 0.924281 -0.019231 0.011270 8.887637  0.000001 ng
31/08/62 0.565290 -0.019231 0.010789 5.627452  0.000001 nau

HANITIATISNANBUENITNTEIBAATINUTIVWT U wRdvazaulug1any lngas e Tude
NARSUTHY IMERG V.06 S2UU Final SauaTuft 25 — 31 899nAu W.A. 2562 1uwumaaamm% Tnely

ad aa 1
Tensainsnanduiudideiud (Global Moran's 1) famamsiwnsresisetu Kn1a 4.3 nui ‘wu‘mqm

v
o a A 1

WY UAT Moran's Index, Expected Index, Variance, Z — Scores, P-Value qaﬁqﬂufuﬁ' 27 @9nAy
WA, 2562 AAWYINAU 0.675040, -0.038462, 0.010925, 6.826331, 0.000001 MUY wazdlA1 Moran's
Index, Expected Index, Variance, Z — Scores, P-Value mmamimuw 28 AU W.A. 2562 HAWINAU

-0.128066, -0.038462, 0.008095, -0.995931, 0319284 n gy InpNuiiduthdfiaauandiniudiae

Aunluiienadeiiu taun sUsuudiinarueisasauwuuiniengy (Clustered pattern) 18331019

1%
1 [ =

YN[ UUIY o

q

A1 Z = Scores UINNI1 +1.96 WAy +2.58 WAAIDIAMUAUNUS LT IN UA bUNI9UIN

=%

'
Y [ aa 1 1 a

pealifudfn1ead P-Value Uaanin 0.05 way 0.01 AszAuanudiatiu 95, 99 Waosidud audimu

o

a

onciuiuil 28 Aamen na. 2562 fiAfinnuavduiusidsiiufisuluudy (Random pattern) Lila9a1n

Y

silufiquingauazquiing dan Z - Scores daunda -1.65 uansdsanuduiudideaiiuilunsavegng

HedAgyneadia P-Value tounin 0.10 isgAumnudety 90 wWestiun
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(%
[y

M19197 4.3 M3ATIEN Global Moran's | Yasfiuguun¥s e T

4
o A

GHERL
’3’14‘17; Moran's Index Expected Variance  Z - Scores P-Value g‘tJLl,‘U‘U
Index
25/08/62 0.675040 -0.038462 0.010925 6.826331  0.000001 ng
26/08/62 0.215590 -0.038462 0.011603 2.358515 0.018348 &
27/08/62 0.347283 -0.038462 0.008409 4.206459  0.000026 &
28/08/62 -0.128066 -0.038462 0.008095 -0.995931 0.319284 GHY
29/08/62 0.583225 -0.038462 0.011369 5.830570  0.000001 nau
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Abstract

This study aims to study and analyze meteorological physical characteristics during
Tropical Storm Podul affected on the Mun and Chi River basins of Thailand. The spatial
distribution characteristics of both eventual and daily cumulative average rainfall have been
analyzed from on the day 25 August 2019 to 31 August 2019. ERA5 data has been used to
analyze at global pressure and time intervals. Rainfall products derived from IMERG V.06
Final Run system has been used to understand spatial pattern via using spatial statistics such
as Spatial autocorrelation (Global Moran's 1), Cluster and Outlier analysis (Anselin Local
Moran' s 1) and Hot Spot analysis (Getis-Ord Gi¥).

The study results provide an understanding into the nature of storm movement and wind
speed, temperature and humidity that using ERA5 weather data each day since originating
in the Pacific Ocean to the dissipating in the Northern Thailand. The storm landing areas may
be less affected than areas that are not directly affected by the storm such flooded aspect.
The statistical analysis results in the Mun and Chi River basins showed that the clustered patterns
of mean rainfall has shown the similarity in the same direction with statistical significance.

Key Words: Rainfall products, GPM, IMERG, ERA5
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